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Outline

* Programming
— Scripts
— Functions
— Debugging Environment
— Conditional Execution

* Visualization
— Two-Dimensional Graphing
— Three-Dimensional Graphing
— Saving Graphs
— Presentation
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Scripts - New File
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Matlab commands can be placed 1n a file for repeated
execution

Such files typically use the extension ‘.m’
Files can be created 1n any text editor
Create a new file in Matlab’s editor in the File menu

<) MATLAB

|File Edit  View Web ‘Window Help

Cpen, .. Chrl+ O Figure
Close Command Window  Ckrl4+WW Model
&l ]

Impart Data...
Save Woarkspace As,..  Ckrl+5

Set Path...
Preferences...

Prink...
Prink Selection, ..

Exit MATLAB k4G
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Scripts - Editor/Debugger
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* The resulting window 1s the Matlab Editor/Debugger

8} untitledz*

File Edit “iew Text Debug Breakpoints web ‘Window Help
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Scripts - Context
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* A script executes as 1f typed from the command line
* Same context

— variables defined in the Command Window are visible
in the script

— variable creation/changes/clearing in the script will be
visible in the Command Window

* No parameters can be passed to a script

No return values can pass from a script
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Scripts - Demo
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A demo script created in the Editor/Debugger
Line numbers automatically included
Comments begin with ‘%’

Save As... to be able to execute the script

3] H:'Instruction‘MatlabTutorial'DemoScri - |I:I|£|
File Edit ‘iew Text Debug Breakpoinks ‘Web Window  Help

NSEE ‘2R o o @AH S8 x

F

1 % Demao script f£ile
2 % Azsume wariable 4 1z already defined
3
4 —| mwmyREesult = 4 + &
s
f % Change the walue of 4
fi
- &4 = 1;
1
Feady
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Scripts - Execution
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* Type the script name to execute 1t
 Script output appears in the Command Window

* Press <Ctrl> - C to stop execution of any command
prior to termination

>> A=5;
>> DemoScript

myResult =
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Scripts - Current Directory

Programming | '« To execute, the script file must be:

Scripts . .
, — 1n the current directory, or
Functions
Debucting — 1n a directory in the search path
giggdgggal e The Current Directory panel shows the contents of the
L current directory and lets you change the location
Visualization
2-DGraphs | * Double-click an M-file to open it in the editor
3_D Graphs Current Directory |
Savin IH:‘-.Instructinn‘-.l-[atlahmtnrialll J| ﬁ | ﬂ
Graphs _ . o
All files File Type Lazt Modified
Presentation E DemoScript.m 13-Sep-2001 01
D.I-Iatlah.d::n: 07-3ep-2001 11:1(
[ Matlah.pds 07-Sep-2001 11:!
[:]matlab tutorial... 21-Jan-2000 12:f
DHatlah_'I'thnrial. . 13-3ep-2001 01::
D.Hatlah_mtnrial. . 13-3ep-2001 0Ol::
D'I‘utu:urialﬂlides_. . 07-3ep-2001 1Z:.
DTutnrialSlides_. . 07-3ep-2001 12:.
J | o
4| ¥ | CommandHistory  Current Directory I
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Scripts - Search Path
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Mew k
CIpEM. .. Chpl+iC
Close Current Direchary  ChrlH-i

Imnport Daka. ..
Save Warkspace A5, Chrl45

Set Path, ..

Preferences, .,

Primt, . ZEHH-F
Primt Selection. ., .

Exit MATLAB Chrl+G

* To examine the search path, open Set Path

* To update the path in a script, use addpath

File Edit “iew Web Window Help

All changes take effect immediately.

Add Faolder...

Add with Subfolders...

flove to Tap

Mmve g

FEemaye

{1 [ = I

flowe tm Bottom

Save Close

MATLAB search path:

=10 x|

g HMnstruction\MatiabTutarial
[ citemnp

[Lgd

[ piimatlabr! 2toolboximat217

4

L Fimatiabr! 2toolhodimatiabigeneral
[ Pwmatlabr! Atoolboxdmatiablops

[ Pwmatlabr! 2toolboxdmatiabilang
[ Pwmatiabr! 2toolboxdmatiabielmat
[ Pvmatlabr! 2itoolboxdmatiabielfun
[ Fmatlabr! 2toalhoximatiabis pecfun
[ Pumatlabr! 2toolboxdmatiabumatiun
[ Pwmatiabr! 2toolboximatiabidatafun

f_\_I D -iematlAboed Miteadboesdrea st A kbdsaedism

| FEevert Default
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Functions - Context
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* A function 1s a special type of M-file
* Different context

— variables defined 1in the Command Window are not
visible in the function

— varlable creation/changes/clearing in the function will
not be visible in the Command Window

* Parameters can be passed to a function

— Parameters are passed by reference unless they are
modified within the function

— You cannot force pass by reference nor are data pointers
supported

— Matlab does support global variables (global) and simple
context switching (evalin, assignin)

* Return values can pass from a function
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Functions - Demo

Programming
Scripts
Functions
Debugging

Conditional
Execution

Visualization
2-D Graphs
3-D Graphs

Savin
Graphs

Presentation

* Function files begin with the syntax:

function [retl, ret2, ....] = myfun(paraml,param2,....)

* Comments immediately after the declaration appear in
the Command Window when you type ‘help myfun’

8} H:\Instruction',MatlabTutorial, DemoFunction.m
File Edit “jew Text Debug EBEreakpoinks ‘Web ‘Window Help

NESEHES | 2re - |@p| @R[ E2E B[ = = x

=10 x|

1 function [r_sum,r diff] = DemoFunction(p a,p bj | —

2 5

3 % Thiszs function returns the sum and difference

4 % between the Lwo parameters.

al

Bl—-| rsum =p a4+ p b;

fl=| r diff =p a - p bh:

g | | -
Al >

Feady
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Functions - Invoking

Programming | « [pnvoke the function like any other Matlab function

Seripts * To accept multiple return values, place them in square

Functi
HEHOT brackets [ ]
Debugging

Conditional
Execution

Visualization

2-D Graphs
3-D Graphs >> help DemoFunction

Savin
Graphs

This function returns the sum and difference
Presentation between the two parameters.

>> [theSum, theDiff] = DemoFunction([1l 2 3],1)

theSum =

2

theDiff

0
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Debugging - Set Breakpoint

Programming | '« The Editor/Debugger also allows interactive debugging
Seripts of functions and scripts
Functions ) .
DERIETIE * Move the cursor to the line debugging should start and
Conditional click the Set/clear breakpoint icon
Execution
Visualization
2-D Graphs
3-D Graphs B} H:\ Instruction',MatlabTutorialDemoFunction.m ;IEIEI
Savin File Edit View Text Debug Breakpoints ‘Web Win ndai
Graphs EEHE| 2B o|d@p Em%@r@@wwl__lam x|
Presentation 1 function [r_sum,r diff] = Demnm%ﬁp a,p_bl =]
2 %
3 % This function returns the sum and difference
4 % bhetween the two parameters.
5
b & Ir_su.m = p a+ p h;
fl-| r diff = p a - p b;
A ~
0 |L|_‘
Feady
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Debugging - Control

Programming | '« The debugger provides control over execution
Scripts

, 4] — executes the current instruction
Functions
Debugging 32 — jumps into a subroutine
Conditional .
Execution Ef — executes through the end of a subroutine
Visualization . .
I[5] — continue execution
2-D Graphs
3-D Graphs | #=] — stop debugging
Savin _
Grap S 8} H: Instruction'MatlabTutorial'DemoFunction.m ;Iglil
Presentation File Edit “iew Text Debug Breakpoints ‘Web ‘Window Help
NEE&| =mo o @dp| 8| QDR R | suuwomerud x
1 function [r_sum,r diff] = DemoFunction(p _a,p b) ;l
2 %
3 % Thiszs function returns the sum and difference
4 % bhetyeen the two parameters.
]
@[ p sum = p a + p b;
fl—| r diff = p a - p b:
° B
] Irl_‘

Ready
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Debugging - Variables and Errors

Programming | o  Paysing the pointer over a variable shows its value

SCl‘iptS B} H:\Instruction'MatlabTutoriali DemoFunction.m _ IEll EI
Functions File Edit “iew Text Debug Breakpoints ‘Web ‘Window Help
Debugging E %| u:IHI:- ‘ E ) L | ﬂ _fl* | a ﬁ | @ % EI l@ ﬁ| Sta-:kl[?'em-:nFunctlmil
.. 1 function [r_sum,r diff] = DemoFunctionip a,p b)
Conditional 5 y —
Execution 3 % Thiz function returns the sum and difference
. . . 4 % between the Two parameters.
Visualization 5
@G ¥ sum = p a + p h:
2-D Graphs 2= ©aiff -5 oa - g b
3-D Graphs g p a = I
Savin o1 1 z 3 b
Graphs Ready
Presentation

» Breakpoints can also be set for errors, etc.

B} H:\Instruction'MatlabTutorial'.DemoFunction.m
File Edit Wiew Text Debug | Ereakpoinks ‘Web ‘Window Help

SekfClear Breakpoint F12
iClear All Breakpoinks

Stop IF Error
Stop IF WWarning
Stop IF Mal Or Inf
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Debugging - Command Window

Programming | o  Command Window prompt changes when debugging

o t O ° °
SERIDLS * You can evaluate expressions in the function context

Functions

* You can change the value of parameters and local
variables

Debugging

Conditional
Execution

Visualization
2-D Graphs
3-D Graphs

Savin
Graphs

Presentation
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Conditional Execution - Logical Arrays

Programming | « Some operators return logical arrays

Seripts » Logical arrays can be operated upon like floating-point

Functions 7
Depuerine * Bitwise operators are:

Conditional & - AND

Execution

Visualization
2-D Graphs
3-D Graphs

Savin
Graphs

Presentation

>> (D>2) & (D<4)

ans =
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Conditional Execution - if Construct

Programming | o (Construct

Scripts if expr

Functions statementl
i else

Debugging statement?

Conditional end

Execution

executes statementl if all elements of expr are non-

Visualization . .
zero, otherwise statement? 1s executed

2-D Graphs

3-D Graphs >> if (D>3)

. disp('All elements are greater than three');
Savin else

disp('Some elements are not greater than three');

Graphs

Presentation end
Some elements are not greater than three
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Conditional Execution - for Construct

Programming | o (Construct

Scripts for var = expr
Functions statements
Debugging end
Conditional assigns columns of expr to var in turn
Execution

Visualization
2-D Graphs
3-D Graphs >> forlv=l:5
Savin enddlSP (v)
Graphs
Presentation
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Conditional Execution - while Construct

Programming | o (Construct

Scripts while expr
Functions statements
Debugging . end .
Conditional iterates until all elements of expr are zero
Execution
Visualization
2-D Graphs

3-D Graphs >> A=0;
>> while A ~= 5

Savin dis -
p(A);

Graphs A=A+ 1;

Presentation end
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2-D Graphs - Figure Windows

Programming | « (reate a figure window with ‘figure’

Script
Fc“p :  The figure command returns a handle for later use
unctions .
Debugeing | © Also use figure(H) to make H the active figure
conditional | * Use close(H) to close figure H
Execution
Visualization
2-D Graphs
3-D Graphs >> myFig = figure
Savin o =
Graphs myFig =
Presentation 1

myFig2 = figure;

% This will bring myFig forward and make it active
figure (myFig)

% This will close myFig2
close (myFig2)
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2-D Graphs - Plotting
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* Make a plot in the current figure window with ‘plot’
— First parameter 1s an array of X values
— Second parameter 1s an array of Y values
— Third parameter can specify a color and line style

0 <} Figure Mo. 1 =10 x|
>> theta=0 . O . 2 . 2 *pl ; File Edit Wiew Insert Tools Window Help

>> plot(theta,sin(theta)) Insda/ yAa A/ ppn

1

08

06|

0.4}

02r

aF

021

o4t

06}

081
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2-D Graphs - Overlaying Plots

Programming |« Simply plotting again will replace the old plot

SERIpLS * To overlay a plot, use 'hold on'. To replace again, use

Functions 'hold off"...

Debugging

Conditional * >>hold on

Execution « >> plot(theta,sin(theta),'r")
Visualization

2-D Graphs

3-D Graphs >> plot (theta,cos(theta), 'g')

. >> hold on

Savin >> plot (theta,sin(theta),'r"')

Graphs

Presentation
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2-D Graphs - Overlaying Plots
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<} Figure No. 1

File Edit “iew Insert Tools ‘Window Help

=10 |

lozaa ya 2/ 220

0.8 F

0.4 -

0.2 F

H2F

0.6

SIREN
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2-D Graphs - Labeling Plots

Xias Y

min? max? min?® Ymax])

Programming | o  Change axis ranges with axis([X

Scrint . : . .
CHpE * Always label a plot with legible information
Functions )
: — Title text
Debugging )
Conditional — Legend if more than one plot
Execution — Labels for X and Y axes
Visualization
2-D Graphs
3-D Graphs title('Sine and Cosine values', 'FontSize',b 14)
. L = legend('Cosine', 'Sine') ;
%avm xlabel ('Angle in Radians', 'FontSize',12)
raphs ylabel ('Function Value', 'FontSize',12)
Presentation

EE Matlab Tutorial II: Programming and Visualization 25



2-D Graphs - Labeling Plots
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<} Figure No. 1

File Edit Wiew Insert Tools ‘Window Help

=10f x|

DEsE& NA A A/ | BED
Sine and Cosine values

Function Value

Andle in Eadians
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2-D Graphs - Subplots

Programming | « Tile more than one plot in a figure with
Seripts subplot(rows, columns, current)
Functions ,

Debugging * Make polar plots with polar(theta, rho)

Conditional | * Plot discrete sequence data with stem(X, Y)

Execution . . .

o * Make piecewise constant plots with
Visualization

2-D Graphs

3-D Graphs myFig2 = figure;

Savin o .

Graphs s First we make a polar plot...

subplot(2,1,1)

Presentation title('Advanced Plotting', 'FontSize', 14)
polar (theta,l-sin(theta));

Xxlabel ('Polar Plot Example', 'FontSize',12)

(o)

% ...then we add a stem plot...

subplot (2,1, 2)

stem(theta, cos (theta))

Xxlabel ('Sample Location', 'FontSize',12)
ylabel ('F[n] ', 'FontSize',12)
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2-D Graphs - Subplots
Programming =101 x|

File Edit Miew Insert Tools  Window Help

DEzE&E XA A/ @20

Scripts
Functions
Debugging

Conditional
Execution

Visualization
2-D Graphs
3-D Graphs

Savin
Graphs

Presentation
1':} ':- T T T T T

[n]
—o

= ¢
u_uﬁ ﬂ$li ll$¢

_"I | | Iy Ty | | |

T

0 1 2 3 4 ] b 7
Sample Location
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2-D Graphs - Other Plots and Editing

Programming
Scripts
Functions
Debugging

Conditional
Execution
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Savin
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Presentation

« Matlab provides many other two-dimensional graphs
— bar( ) creates bar charts
— pie( ) creates pie charts
— loglog( ) creates plots with logarithmically space axes

— semilogx( ) and semilogy( ) create plots with one axis
logarithmically spaced

* Use the Edit Plot tool to select items 1n a plot

— double-click axes, plots, etc. to change their properties

<3 Figure No. 2

File Edit “iew Insert Tools ‘Window Help

DEE&E A2/ B0

WWWWWWH\HW
-
uuuuuuumuuuuuuuumuummuu\HMHHHH\HW
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3-D Graphs - Plotting

Programming | o [Jse ‘plot3’ to plot three-dimensional curves

ST — First parameter is an array of X values

Functions .
Debusei — Second parameter 1s an array of Y values
ebugging . .
Conditional — Third parameter is an array of Z values
Execution
Visualization
2-D Graphs
3-D Graphs >> figure
. >> theta2 = 0:0.2: (20*pi);
Savin >> plot3 (theta2,cos(theta2),sin(theta2))
Graphs
Presentation
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3-D Graphs - Plotting
Programming

. File Edit Miew Insert Tools Window Help
Scripts

=101 %]

DEE& NA A/ BED

Functions
Debugging

Conditional
Execution

Visualization
2-D Graphs
3-D Graphs

Savin
Graphs

Presentation
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3-D Graphs - View Direction

Programming |« [Jse the rotate tool to change the viewing direction -

Seripts click and drag in the plot
Functions =} Figure No. 2
Debugging File Edit View Insert Tools ‘Window Help
Exeeution. | DS ES kA A/ |[S
Rl zaon B e R S T ==
2-D Graphs lDsE&E& NA A/ 22
3-D Graphs
Savin
Graphs
Presentation |

bz 2R EL 32
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3-D Graphs - Mesh Plots

Programming | « [Jse ‘mesh’ to plot three-dimensional wire-frame

Scripts surfaces
L — First parameter is a matrix of X values
Debuggin . .

seme — Second parameter 1s a matrix of Y values
Conditional

Execution — Third parameter i1s a matrix of Z(x,y) values

Visualization * Create evenly spaced coordinates with ‘meshgrid’
2-D Graphs

3-D Graphs figure : :
[X,Y] = meshgrid(0:0.1:2*pi);

Savin mesh (X,Y,cos (X) .*cos (Y))

Graphs

Presentation xlabel ('\theta 1', 'FontSize',12)

ylabel ('\phi 2', 'FontSize',12)

zlabel ('F(\theta 1,\phi 2)', 'FontSize',12)
title('3-D Mesh Plot', 'FontSize',6 14)
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3-D Graphs - Mesh Plots
Programming =101 %]

File Edit Miew Insert Tools ‘Window Help

Scripts - —
, Dzda " A A/ 220
Functions
Debugging 3-D Mesh Plot
Conditional R
Execution
Visualization 1-
2-D Graphs
3-D Graphs 0.5+
Savin G
Graphs < g
. (]
Presentation T
0453 :
: N s
- A
5 . 'E%}}}ﬁﬁh:*ﬁi}’? :

Ll
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3-D Graphs - Surface Plots

Programming |« [Jge ‘surf” instead of mesh to fill the plot with color
Scripts

* Use ‘shading interp’ to interpolate the color smoothly

TS <} Figure No. 1 _ (O] x|
Debugging File Edit ‘“iew Insert Tools ‘Window Help
Conditional Dzda " A A/ @pe o
Execution 3-D Surface Plot
Visualization

2-D Graphs |
3-D Graphs Us
Savin
Graphs 8o \
Presentation P EI-

-

L
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Saving Graphs - .fig Files

Programming
Scripts
Functions
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2-D Graphs
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Savin
Graphs

Presentation

* Figure saving and exporting are available through the
figure’s file menu

File
Mew Figure Zkrl+M
Qpen, .. Ckrl+O
Close kel

Chrl4+5

Preferences,..

Page Setup...

Print Setup...

Prink Prewview, ..

Print. .. ikrl+P

« ‘Save As...” enables you to recreate the figure later

— be sure to specify a file extension “.fig’

* Recreate the figure with the ‘Open...” menu command
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Saving Graphs - Exporting

Programming | o HExport saves a graphic file in one of many formats for

Script . . .
. use in other applications
Functions oot 2]
Debugging Save in: | ‘- MatlabTutorial - « & ef E-
Conditional
Execution
Visualization
2-D Graphs
3-D Graphs
Savin
Grap S File narne: * arpf S ave
Presentation Save az lwpe: | Enhanced metafiles(*. emf) Cancel

K

Enhanced metafiles(*. emf)
Bitmap files*. brp)

EPS files [* epz)

EPS Calor files [*.eps)
EPS Level 2 [*.epz]

EFPS Level 2 Colar [*.epz]
&dobe [lustrataor files [* ai)
JPEG images [*.)pg

TIFF imagesz[*.tif]

TIFF no compression images(©.tif] j

 TIFF and JPEG are useful for including in Word,
PowerPoint, and WWW documents
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Presentation - Microsoft Office

Programming
Scripts
Functions
Debugging

Conditional
Execution

Visualization
2-D Graphs
3-D Graphs

Savin
Graphs

Presentation

* In Microsoft Word or PowerPoint, insert a graphic into

your document from the ‘Insert” menu

Insert
Breal. ..

Page Mumbers...

Dake and Time...

AutoTextk 3

Field. ..
Symbal, ..
ﬁ omment

Footnote. ..
_apkion. ..
Cross-reference. ..

Index and Tables...

Picture 3 lip Art..,

Texk Box
File. ..
iohject, ..
Bookmark. ..

% Hyperlink,..  Ckrl+k
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@f‘ AutaShapes
4 Wordart, .,

ﬂ Mew Drawing

%‘ From Scanner ar Camera. ..

ﬂ Chart
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Presentation - Microsoft Word Layout

Programming |« Doyble-click the graphic and choose the ‘Layout’ tab
Seripts to select text wrap options
Functions

Debugging 2

Conditional Colors and Lines Size L _____ El':-'DLIl: ______ | Picture I Texk Box I Web I
Visualization
2-D Graphs ) l : l : I = af
3-D Graphs In line with Eext Square Tight Eehind text  In Front of kext
Savin
Graphs Horizonkal alignment
Presentation ™ Left " Center ™ Right {+ Cther
fdvanced...
I, I iZancel
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Presentation - LaTeX

Programming
Scripts
Functions
Debugging

Conditional
Execution

Visualization
2-D Graphs
3-D Graphs

Savin
Graphs

Presentation

* Exporting a graphic as encapsulated PostScript (EPS)

1s very useful for preparing typeset documents as with
LaTeX

* In the preamble of your LaTeX document, type
\usepackage{epsfig}
* To create a floating figure within your document:
\begin{figure}
\begin{center}
\begin{tabular}{c}
\psfig{figure=SurfaceColor.eps,width=5in}
\end{tabular}
\end{center}

\caption{Surface plot of my function.}
\end{figure}
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